Supplemental financial assistance to State and local governments and certain private non-profit organizations for response and recovery activities required as a result of a **federally** declared disaster.

Funding is cost shared at a federal share of no less than 75% of eligible costs.
Supplemental financial assistance to State and local governments and certain private non-profit organizations for response and recovery activities required as a result of a **federally** declared disaster.

Funding is cost shared at a federal share of no less than 75% of eligible costs.
The Public Assistance Program assists in the restoration of community infrastructure.

It is a supplemental cost reimbursement program with specific eligibility requirements.

The FEMA share of eligible costs will be awarded to the recipient (grantee) for disbursement to the applicants.
• **FEMA** – manages the program, provides technical assistance, approves grants.

• **State** (Recipient) – educates applicants, works with FEMA to manage the program, implements and monitors grants awarded.

• **Applicant** (Subrecipient) – identifies damage, provides documentation, manages funded projects.
Eligibility Pyramid

- APPLICANT
- FACILITY
- WORK
- COST
Eligible Applicants

- State
- County
- City / Town / Village
- Other political subdivision of the State
- Native American Tribal Governments and Tribal Organizations
- Certain Private Non-Profit Organizations
To be an eligible PNP Applicant, the PNP must show that it has:

• A current ruling letter from the IRS granting tax exemption under 501(c/d/e) or Internal Revenue Code of 1954 or

• Documentation from MS Secretary of State substantiating it is a non-revenue producing non-profit entity doing business under the State Law.
Two categories of PNP

- Critical Services

Eligible for both **Emergency Work** and **Permanent Work**:

- Fire / Emergency Rescue
- Medical Treatment
- Power, Water, & Sewer Utilities
- Communications Systems
- Educational Facilities
Private Non-Profit Entities (PNP)

Two categories of PNP

• Non-Critical/Essential Services

Eligible for **Emergency Work**:

Museums, Community Centers, Libraries, Homeless Shelters, Senior Citizens Centers, Zoos, Day-Care Centers, etc.

Non-critical/Essential PNPs must first apply to the Small Business Administration (SBA) for a disaster loan for permanent repair work before applying to FEMA.
To be eligible, the facility must:

- Be damaged as a **Result of the Declared Event**.
- Located **Within the Presidentially Declared Area**.
- Be the **Legal Responsibility** of an eligible Applicant.
- Not be under the **Authority of a Federal Agency**.
Emergency Work
A. Debris Removal
B. Emergency Protective Measures

Permanent Work
C. Roads and Bridge Systems
D. Water Control Facilities
E. Public Buildings / Equipment
F. Public Utilities
G. Other (Parks, Recreation, etc.)
FEMA is authorized to provide Public Assistance funding for Emergency Work, including emergency protective measures and debris removal.

Emergency Work is that which must be done immediately to:

- Save lives
- Protect public health and safety
- Protect improved property
- Eliminate or lessen an immediate threat of additional damage.
Debris removal is eligible when:

- It eliminates an immediate threat to life, health, and safety
- It eliminates an immediate threat of significant damage to improved property
- It ensures economic recovery of the community and provides a benefit for the community-at-large
Emergency Work
Category B – Emergency Protective Measures

Actions taken by applicants before, during, and after a disaster to save lives, protect public health and safety, and prevent damage to improved property. Includes:

• Search and Rescue; Fire and Flood Fighting

• Security, such as barricades, fencing, or law enforcement.

• Push of Debris (not debris disposal)
Eligible **Permanent** Work:

- Must repair, restore or replace disaster-damaged facilities in accordance with regulations
- Must restore to pre-disaster design, capacity and function in accordance with applicable codes and standards
- Must be required as a result of the disaster
- May include cost effective hazard mitigation measures
**Category C**
**Roads and Bridges**

**ROADS**
- Road
- Surface
- Bases
- Shoulders
- Ditches

**BRIDGES**
- Decking
- Abutments
- Wing Walls
- Approaches

**DRAINAGE STRUCTURES**
- Culverts
- Cross Drains
Facilities built for the following purposes:

- Pumping
- Drainage
- Irrigation
Buildings/Contents
  • 50% Rule
  • Codes/Standard
  • Equipment
  • Vehicles
  • Supplies

DEDUCT INSURANCE AND SALVAGE
Utilities Include:

• Power Generation & Distribution Centers
• Water and Sewer Treatment plants
• Telecommunication systems

Damage must be disaster-related.
• Playgrounds
• Swimming Pools
• Ballparks
To be eligible for reimbursement, costs must:

- Be reasonable and necessary to accomplish eligible work

- A cost is reasonable if, in its nature and amount, it does not exceed that which would be incurred by a prudent person under the circumstances prevailing at the time the Applicant makes the decision to incur the cost
To be eligible for reimbursement, costs must:

- Comply with federal, state, and local laws and regulations.
- Authorized and not prohibited under Federal, State, Territorial, Tribal, or local government laws or regulations.
- Consistent with the Applicant’s internal policies, regulations, and procedures that apply uniformly to both Federal awards and other activities of the Applicant.
Cost Eligibility

To be eligible for reimbursement, costs must:

- Include deductions of insurance proceeds, salvage value, and purchase discounts.
Eligible Direct Costs

Force Account “LABOR”

Category A – Debris Removal/Clearance – Regular/Straight Time and Overtime (including Fringe Benefits) are eligible (new Sandy Recovery Improvement Act of 2013).

Category B – Emergency Protective Measures – Only Overtime is eligible (including Fringe Benefits).

Category C-G – Regular/Straight Time and Overtime (including Fringe Benefits) are eligible.
• Materials – The costs for items used from applicant’s inventory and for items purchased to make authorized repairs to meet the scope of work are eligible.

• Applicant owned Equipment – The costs associated with the equipment used to perform authorized repairs, all operating equipment hours are eligible, should be supported by Labor Time Sheets. Rates based on FEMA Schedule of Equipment Rates.
Types of Projects

- Small Projects
- Large Projects
- Improved Projects
- Alternate Projects
Public Assistance projects are processed as either small or large projects. If the project cost is less than the annually updated cost threshold amount (currently $125,500) the project is processed as a small project. If the project cost equals or exceeds the threshold the project is processed as a large project.
<table>
<thead>
<tr>
<th>Small Projects</th>
<th>Large Projects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Funding is based on work completed (if available) or initial cost estimate.</td>
<td>Initially approved based on estimated costs.</td>
</tr>
<tr>
<td>Federal cost share is paid upon project approval.</td>
<td>Funding is based on documented actual costs.</td>
</tr>
<tr>
<td>When the cost of work is less than $3,140, that work is not eligible.</td>
<td>Federal cost share is paid as work is accomplished.</td>
</tr>
</tbody>
</table>
LARGE PROJECTS NOTE

Any costs above what is approved on the Project Worksheet must be submitted to the State for review and forwarded to FEMA for approval.

All large projects are subject to a Final Inspection Review by both the State and FEMA.
Applicants performing restoration work on a damaged facility may use the opportunity to make improvements to the facility while restoring the facility to its pre-disaster function.

- The improvements **must be approved by the State** prior to construction.
- May require a FEMA Environmental and Historical Assessment.
- The applicant is responsible for the cost of the improvements. Federal funding is limited to the cost of restoration.
When restoration of a damaged facility or function does not serve the public welfare, an applicant may use a Public Assistance grant for another public facility.

- The alternate project must be approved by FEMA prior to construction.
- A request for the Alternate Project must be made within 12 months of the Scoping Meeting.
The alternate project may require an environmental assessment.

Federal funding is limited to 90% of the federal share of the original project estimate or actual Alternate Project costs (whichever is less) for State and local governments, or 75% for PNP applicants.
Time limits for project completion begin on the disaster declaration date.

- Emergency work must be completed within 6 months
- Permanent work must be completed within 18 months
The Recipient can grant time extension for extenuating circumstances. Those extensions are:

- Emergency work: up to 6 additional months
- Permanent work: up to 30 additional months

The Regional Administrator may increase these time extensions on a case-by-case basis.

**NOTE:** If the deadline for any project has been reached, without an approved time extension, no costs past the deadline date will be eligible for funding!
Special considerations are issues other than program eligibility that could affect the scope of work and funding of a project. These issues include:

- Insurance
- Hazard Mitigation
- Environmental Protection
- Floodplain Management
- Historic Preservation and Cultural Resources
Actual or anticipated insurance proceeds will be deducted from the eligible project costs for facilities that are insured.

All applicants are required to obtain and maintain insurance coverage on all insurable facilities as a condition of Public Assistance funding.

For flood damaged facilities located within a Special Flood Hazard Area that are not covered by flood insurance, FEDERAL ASSISTANCE WILL BE REDUCED BY THE MAXIMUM FLOOD INSURANCE PROCEEDS THAT WOULD HAVE BEEN PAYABLE HAD THE FACILITY BEEN INSURED.
Special Considerations

Hazard Mitigation

Larger culvert with concrete wing-walls

Pre-disaster

Disaster damage

Section 406
Special Considerations

Environmental and Historic Preservation (EHP) Compliance

- All FEMA funded projects must comply with a variety of EHP Laws, Regulations and Executive Orders.
- EHP Review is done prior to funding to ensure compliance with applicable Federal laws.
- EHP Review is a collaboration between FEMA, the State, applicants, tribal entities, and local organizations.
- Construction of new facilities, alternate projects, modification, expansion, or mitigation of existing facilities may require more extensive EHP review.
- FEMA must complete review before work starts.
To ensure that all practical means are used to protect, restore, and enhance the environment, FEMA projects must comply with all applicable laws and regulations, including:

- National Environmental Policy Act (NEPA)
- Magnuson Stevens Act
- Endangered Species Act (ESA)
- Clean Water Act (CWA)
- Clean Air Act (CAA)
- 44CFR Parts 9 and 10
Any project within or affecting the floodplain or wetlands must be reviewed to ensure that it meets the requirements of several Federal laws and Executive Orders (EO).

- EO 11988 Floodplain Management
- EO 11990 Protection of Wetlands
- Clean Water Act (CWA)
The National Historic Preservation Act (NHPA) requires FEMA, grantees, and applicants to assess potential effects to historic and cultural resources, such as:

- Historical buildings, structures, and districts
- Archaeological and tribal sites
- Objects and artifacts
FEMA, the state, and the applicant work together to identify and address historic preservation issues before approval of funding for a Public Assistance project.

May require consultation with the State Historic Preservation Office (SHPO), Tribal Historic Preservation Officer (THPO), and Advisory Council on Historic Preservation (ACHP).

Resources are available to applicants on the FEMA website and through FEMA’s Office of Environmental and Historic Preservation (OEHP).
Applying for a Public Assistance Grant

- Applicant must submit a Request for Public Assistance (RPA) within **30 days** of the respective area being designated in the declaration.

- Applicant must submit all damages within **60 days** of the RECOVERY SCOPING MEETING (formerly called the kick off meeting).
- Used to document the scope of work and cost estimate for a project.

- Supplies FEMA with the information necessary to approve the scope of work and fund the project.

- A legal and binding document.
Applicants are required to maintain complete and accurate documentation, by project, for all disaster-related costs.

Documentation must be maintained a minimum of three years after applicant close-out.
What records do I need to keep and for how long?

- Force account labor
- Force account equipment
- Rented equipment
- Materials and purchases
- Photographs of damage, work underway, work completed
- Records of donated goods and services
- Contract Services - Procurement Process; Contracts, Invoices, etc.

Applicants should retain all records for three (3) years from the date of the Final Status Report or the date of the final certification of completion of the applicant’s last project.
Cost Types

- Force Account Labor
- Force Account Equipment
- Material
- Rented
- Contract
- Time and material contracts may be allowed, but should be avoided if possible.
Force Account Labor

- Applicant’s Payroll Policy (prior to disaster)
- Applicant’s Benefits Calculation Worksheet
- Applicant’s Complete Employee List
  - Should include Employee rate
  - Exempt vs. Non-Exempt Employees
- Time Sheets and Payroll Records
- Copies of Cancelled Checks / Proof of Direct Deposit
Force Account Equipment

- Applicant’s Equipment Listing
- Equipment documentation sheets
- Employee timesheets reflecting equipment operated time, date of use etc.
- FEMA Schedule of Equipment Rates
Force Account Materials

- Material Summary Record
- Applicant’s Materials Inventory List dated prior to disaster (i.e. Assets Inventory)
- Materials Requisition Sheets – if available
- Invoices for materials purchased and put in inventory and copies of checks paying the invoices.
Procurement

- Federal, State, Local Requirement, whichever is the most stringent

Procurement

- Training available. Web Search – “Procurement Disaster Assistance Team”
Rented Equipment

- Copies of the signed Rental Agreement(s)
- Invoices
- Verify proof of payment
Any determination related to Federal Assistance may be appealed.

The appeal must be submitted in writing to the State (Grantee) within 60 days of receipt of notice of the action being appealed.

- State has 60 days from receipt of appeal letter to forward it to FEMA.
- FEMA has 90 days to render a decision.

Two levels of appeal are available:
1) to the Regional Administrator and
2) to the Assistant Administrator for Disaster Assistance Directorate.
Debris Removal Operations
- Straight time F/A Labor eligible.
- Allows use of sliding scale for debris costs to incentivize operations if State has over $20M in debris costs.
- Applicant can retain earnings from recycling.
- Debris management cost share increase (2%) for a FEMA pre-approved debris management plan.

<table>
<thead>
<tr>
<th>Time Frame (Days after Start of Incident Period)</th>
<th>Federal Cost Share</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-30</td>
<td>85%</td>
</tr>
<tr>
<td>31-90</td>
<td>80%</td>
</tr>
<tr>
<td>91-180</td>
<td>75%</td>
</tr>
<tr>
<td>181+</td>
<td>0% unless FEMA approves extension</td>
</tr>
</tbody>
</table>
Public Assistance Alternative Procedures Pilot Program for Debris Removal

- Alternative Procedures for Debris Operations is Voluntary
- If Applicant chooses to participate in Alternative Procedures then the Applicant must sign the Participation Acknowledgement Letter
- Pilot Program scheduled to end June 27, 2018.
• **Permanent Work**
  • Grants Based on Estimates (Capped)
    • Cost overrun absorbed by applicant
    • Under run can be used by applicant for specific mitigation uses (must be approved by FEMA)
  • Applicant may consolidate multiple projects in one Project Worksheet (PW)
  • FEMA may accept applicant’s licensed engineer’s cost estimates
  • Must be very sure of costs to use this method
  • Over runs in permanent work is common
Public Assistance Alternative Procedures Pilot Program for Permanent Work

- Alternative Procedures for Permanent Work is Voluntary
- If Applicant chooses to participate in Alternative Procedures then the Applicant must sign the Participation Acknowledgement Letter

Public Assistance Alternative Procedures Pilot Program for Permanent Work Acknowledgement

In accordance with the Sandy Recovery Improvement Act of 2012, the Federal Emergency Management Agency (FEMA) is implementing alternative procedures for the Public Assistance (PA) Program through a pilot program. As a representative of the Subgrantee, our agency understands the following:

1. We plan to participate in the following elements:
   - $\square$ Subgrants based on fixed estimates, and as the Subgrantee, accept responsibility for costs above the estimate
   - $\square$ Consolidation of multiple fixed subgrants into a single subgrant
   - $\square$ FEMA validation of Subgrantee-provided estimates
   - $\square$ Utilization of reduced eligible funding for alternate projects
   - $\square$ Use of excess funds
   - $\square$ Review of estimates by an expert panel for projects with a Federal share of $5$ million or greater

2. The pilot is voluntary, and a Subgrantee may participate in alternative procedures for one or more large subprojects.

3. If the Subgrantee accepts a fixed subgrant estimate, the Subgrantee understands they are responsible for all costs greater than the fixed amount.

4. The Subgrantee agrees to notify the Grantee regarding the specific use of excess funds.

5. All contracts must comply with local, State, and Federal requirements for procurement, including provisions of 44 CFR Part 13.

6. The Office of Inspector General may audit any Subgrantee and/or subgrant.

7. EHF review must be completed for all subgrants, including cases where new scopes of work would require EHF compliance, before the subgrant scope of work is implemented. Failure to comply with this requirement may lead to loss of federal funding.

8. The Subgrantee may submit appeals in accordance with 44 CFR206.206. However, FEMA will not consider appeals solely for additional costs on fixed subgrants.

---

Signature of Subgrantee’s Authorized Representative

Printed Name and Title

Subgrantee Name

PA ID Number

We elect to $\square$ participate in the Alternative Procedures for Permanent Work.
New Delivery Model

**Phase I – Operational Planning**

Objective: Identify Applicants’ Disaster Impacts and Recovery Priorities

1. Presidential Disaster Declaration
2. Region Develops Disaster Operating Profile
3. Recipient Conducts Applicant Briefings
4. Applicant submits Request for Public Assistance
5. JFO conducts training and orientation
6. JFO supervisors establish lean management structure
7. Is Applicant Eligible?

Determination Memo

**Decision Points:**
- **YES**
- **NO**

**Roles:**
- **Region**
- **JFO/Field**
- **Applicant**
- **CRC**
Phase I – Operational Planning (continued)

FEMA Assigns PDMG (Program Delivery Manager)

YES

PDMG Completes Exploratory Call

Applicant Completes Initial Damage Inventory

PDMG Conducts Recovery Scoping Meeting

JFO supervisors establish lean management structure

Exploratory Call
- PDMG explains the PA Program
- Discusses damages
- Introduces Damage Inventory
- Discuss documentation
- Discuss/schedule Scoping Meeting

Region
JFO/Field
Applicant
CRC
New Delivery Model

Phase I – Operational Planning (continued)

- YES

FEMA Assigns PDMG (Program Delivery Manager)

PDMG Completes Exploratory Call

Applicant Completes Initial Damage Inventory

PDMG Conducts Recovery Scoping Meeting

Damage Inventory
- Applicant captures all disaster related damages
- Submitted through Grants Portal
- Initial Inventory submitted before Recovery Scoping Meeting

JFO supervisors establish lean management structure

Region
JFO/Field
Applicant
CRC
Phase I – Operational Planning (continued)

**FEMA Assigns PDMG (Program Delivery Manager)**

**PDMG Completes Exploratory Call**

**Applicant Completes Initial Damage Inventory**

**PDMG Conducts Recovery Scoping Meeting**

- **YES**
  - JFO supervisors establish lean management structure

**Recovery Scoping Meeting**
- Damage Inventory discussed
- Documentation discussed
- Special Considerations discussed
- 60-day calendar discussed
- Site Inspections discussed

**Facility Eligible?**

**Region**
- JFO/Field
- Applicant
- CRC
Phase II – Damage Intake and Eligibility Analysis

- Work complete? YES
  - PW formulation Lane

- Work complete? NO
  - Standard Project Lane

- Work Eligible? NO
  - Special Project Lane

PDMG
Program Delivery Manager

CRC
Consolidated Resource Center
**Phase III**

Objective:
CRC develop the DDD/SOW/costs for completed work
CRC develop the SOW/costs for Standard and Specialized projects
CRC validates Applicant-provided SOW/costs for work to be completed
Obtain Applicant signature on projects

- CRC Peer Review
  - Determination Memo
    - Is Cost/Work Eligible?
      - NO
  - QA, Insurance, Mitigation Reviews
  - Determination Memo
    - Above minimum threshold?
      - NO
        - EHP Review
Phase IV

Objective: Obligate projects, complete the Recovery Transition Meeting with the Applicant, and transition Field Operations to the Region.

PDMG Review → Recipient Review → Applicant Reviews and Signs Project → Final Review / Award in EMMIE → PDMG Conducts Recovery Transition Meeting → Transition Field Operations to Region → CRC Completes All Initial Sub Awards
Who should be your Applicant Agent?

- Understands Program Elements
- Familiar with Computer
- Well Organized
- Readily Available
Pilot Program for Direct Administrative Costs (DAC)

Applicant can opt into the Pilot Program resulting in a Project Worksheet dedicated for DAC

That PW will be obligated at 4% of eligible costs for all the Applicants’ projects.

Timely project/applicant closeout will result in an additional 1%. 
Extra – How to get Reimbursed earlier
Three Questions
Is it eligible?

Eligible Applicant?
Eligible Facility?
Eligible Work?
Three Questions

- Is it eligible?
- Is it reasonable and necessary?

A cost is reasonable if, in its nature and amount, it does not exceed that which would be incurred by a prudent person under the circumstances prevailing at the time the Applicant makes the decision to incur the cost.
Three Questions

- Is it eligible?
- Is it reasonable?
- Is it properly procured?

Were goods and services procured utilizing the most stringent of standards: federal, state, local?
The Public Assistance Program assists in the restoration of community infrastructure.

It is a supplemental cost **REIMBURSEMENT** program with specific eligibility requirements.

The FEMA share of eligible costs will be awarded to the recipient/grantee for disbursement to the applicants.
Questions?

Lee Smithson  
Governor’s Authorized Representative  
601-933-6362 or lsmithson@mema.ms.gov

Stephen McCraney  
State Coordinating Officer  
601-933-66354 or smccraney@mema.ms.gov

Clayton French  
State Public Assistance Officer  
228-860-1954, 601-933-6886 or cfrench@mema.ms.gov